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CHAPITRE 1. INTRODUCTION

1.1. RED HAT JBOSS BPM SUITE

Red Hat JBoss BPM Suite est une suite de gestion de processus d'entreprise open source qui combine
la gestion des Business Process et la gestion des règles métier. Elle permet aux utilisateur IT
d'entreprises de créer, gérer, valider et déployer des Business Process et les règles

Red Hat JBoss BRMS et Red Hat JBoss BPM Suite utilisent un répertoire centralisé, où toutes les
ressources sont stockées. Cela garantit la cohérence, la transparence et la capacité d'audit au sein de
l'entreprise. Les utilisateurs professionnels peuvent modifier la logique métier des processus
commerciaux sans avoir besoin des services du personnel du service informatique.

Pour accommoder le composant Business Rules, Red Hat JBoss BPM Suite inclut Red Hat JBoss
BRMS intégré.

Business Resource Planner est inclus comme aperçu technologique dans cette version.

Rapporter un bogue

1.2. COMPOSANTS DE RED HAT DEVELOPER SUITE

Red Hat JBoss BPM Suite contient les composants suivants :

Moteur d'exécution

L'environnement de runtime des ressources d'entreprise (Processus, Tâches, Règles, etc.). Pour plus
d'informations, consulter Red Hat JBoss BPM Suite Administration and Configuration Guide.

Référentiel Artifact (Knowledge Store)

Un stockage de ressources d'entreprise qui fournissent des capacités de révisions (connecte les
référentiels GIT aux ressources d'entreprise).

Business Central

Une application web pour la création de ressources, pour la gestion et le contrôle des actifs de
l'entreprise fournissant un environnement intégré avec les outils respectifs, tels que les outils de
création, les outils de gestion des ressources d'entreprise pour le travail dans le référentiel Artifact,
les outils de gestion de données de runtime, les éditeurs de ressources, les outils BAM (Business
Activity Monitoring), les outils de gestion de tâches et les outils BRMS. Pour plus de détails, reportez-
vous au Red Hat JBoss BPM Suite User Guide.

Rapporter un bogue

1.3. CAS D'UTILISATION : SOLUTIONS BASÉES SUR LES PROCESSUS
DANS LE SECTEUR DES PRÊTS

BPMS (Red Hat JBoss BPM Suite) peut être déployé pour automatiser les processus métier, comme
l'automatisation du processus d'approbation des prêts auprès d'une banque. Il s'agit d'un déploiement
classique « axé sur les processus spécifiques » qui pourrait être la première étape dans le cadre d'une
plus large adoption de BPM dans une entreprise. Elle s'appuie à la fois sur BPM et les fonctionnalités de
règles métier de BPMS.

Guide de démarrage
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Une banque de détail propose plusieurs types de produits de prêt avec des modalités et conditions
d'admissibilité qui varient. Les clients ayant besoin d'un prêt doivent déposer une demande de prêt
auprès de la banque, qui traite ensuite l'application en plusieurs étapes, en vérifiant de l'admissibilité,
définissant les termes du contrat, recherchant toute activité frauduleuse et déterminant le produit de prêt
le plus approprié. Une fois approuvé, la banque crée et finance un compte de prêt pour le déposant, qui
peut alors avoir accès aux fonds. La banque doit s'assurer de se conformer à toutes les réglementations
bancaires à chaque étape du processus et elle doit gérer son portefeuille de prêts en vue de maximiser
la rentabilité. Des politiques sont en place pour aider à la prise de décisions à chaque étape, et ces
politiques sont gérées activement afin d'optimiser les résultats pour la banque.

Les analystes d'affaires de la banque modélisent les processus de demande de prêt en utilisant les outils
de création de BPMN2 (concepteur de processus) dans la Suite BPM :

Figure 1.1. Flux de processus d'application de prêt de haut niveau

Des règles de gestion (Business Rules) sont développées avec les outils de création de BPM Suite afin
d'appliquer des politiques et prendre des décisions. Les règles sont liées aux modèles de processus
pour faire appliquer les politiques qui conviennent à chaque étape du processus.

L'organisation IT de la banque déploie la BPM Suite pour que le processus d'application de la demande
de prêt soit totalement automatisée.

Figure 1.2. Automatisation du processus de demande de prêts

Le processus de prêt en totalité et ses règles sont modifiables à tout moment par les analystes de la
banque. La banque est en mesure de s'adapter à tout instant à l'évolution de la réglementation et est
capable de rapidement vous présenter des nouveautés en matière de prêt et d'améliorer les politiques de
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prêt, afin de rester dans la course et générer des profits.

Rapporter un bogue
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CHAPITRE 2. GUIDE DE DÉMARRAGE DE RED HAT JBOSS
BPM SUITE
Dans cette section, nous téléchargeons, installons et exécutons BPM de Red Hat JBoss avec un
minimum d'instructions. Pour obtenir des informations supplémentaires sur les étapes et sur les autres
méthodes possibles d'installation, passez cette section et continuez la lecture de ce guide.

Ces instructions assument que vous possédez la version Java prise en charge au minimum sur votre
système. Un serveur Red Hat JBoss EAP existant n'est pas requis car le programme d'installation en
installera un si on ne peut pas le détecter.

Procédure 2.1. Guide de démarrage de BPM Suite

1. Télécharger le programme d'installation BPM Suite à partir de access.redhat.com.

2. Démarrez le programme d'installation par la commande suivante :

java -jar jboss-bpms-installer-VERSION.GA-redhat-MINOR.jar

3. Faire défiler les étapes d'installateur de GUI en notant le nom d'utilisateur/et le mot de passe
pour accéder à l'application BPM Suite après l'installation.

4. Après une installation réussie, dans une invite de commandes, placez-vous dans le dossier où
vous avez installé EAP BPM Suite.

5. Démarrer le serveur BPM Suite par la commande suivante :

bin/standalone.sh

6. Ouvrir un navigateur et connectez-vous au Business Central en naviguant dans 
http://localhost:8080/business-central/. Connectez-vous en utilisant la paire nom
d'utilisateur/mot de passe pour accéder à l'application BPM Suite que vous avez créée lors de
l'installation.

Vous avez maintenant réussi l'installation et vous pouvez exécuter BPM Suite. Vous pouvez maintenant
procéder à ce qui suit :

Pour en savoir davantage sur les roles : Section 3.1.3, « Définir les rôles »

Créer des utilisateurs supplémentaires : Section 3.1.4, « Création des utilisateurs »

Créer un projet Hello World : Chapitre 5, Projet Hello World

Familiarisez-vous avec le guide d'exemples d'applications BPM Working with the BPM Suite Example App

Trouver les directives d'installation du programme d'installation : Installation Guide

Rapporter un bogue
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CHAPITRE 3. OPTIONS D'INSTALLATION
Red Hat JBoss BPM Suite est fournie en deux versions :

Installateur jar exécutable pour installer dans Red Hat JBoss Enterprise Application Platform
(EAP) 6.1.1.

Installation en fichier compressé qui vient en deux versions :

jboss-bpms-6.MINOR_VERSION-redhat-x-deployable-eap6.x.zip : version
adaptée pour un déploiement sur la plateforme Red Hat JBoss Enterprise Application
Platform (EAP 6.1.1).

jboss-bpms-6.MINOR_VERSION-redhat-x-deployable-generic.zip : la version
déployable contenant des bibliothéques supplémentaires adaptées à un déploiement sur le
serveur Red Hat JBoss Web Server (WS), Apache Tomcat 6, et Apache Tomcat 7.

Suivant votre environnement, vous pouvez choisir l'option d'installation qui conviendra le mieux aux
besoins de vote projet.

Rapporter un bogue

3.1. L'INSTALLATION DU GROUPEMENT EAP6

Cette section décrit l'installation du package Red Hat JBoss BPM Suite déployable dans Red Hat JBoss
Enterprise Application Platform (EAP).

NOTE

La configuration minimum prise en charge pour l'installation de Red Hat JBoss EAP pour
Red Hat JBoss BPM Suite est 6.1.1 et non pas 6.1.0.

Rapporter un bogue

3.1.1. Installer le package EAP 6

Pour télécharger le package Red Hat JBoss BPM Suite dans JBoss Enterprise Application Platform,
procéder ainsi :

1. Allez dans Red Hat Customer Portal et connectez-vous.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu déroulant Product, sélectionner BPM Suite.

4. À partir du menu déroulant Version, sélectionner la version du produit.

5. Dans le tableau, allez sur la ligne Red Hat JBoss BRMS Suite 6.0.2 Deployable for 
EAP 6.1.1 puis cliquer sur Download.

Rapporter un bogue

3.1.2. Installer le package EAP6
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Pour installer le package déployable d'EAP non encore configuré, procédez ainsi :

1. Extraire le package zip déployable d'EAP que vous avez téléchargé du portail clients Red Hat
Customer Portal.

2. Faîtes fusionner le package zip extrait d'EAP dans le répertoire SERVER_HOME EAP.

AVERTISSEMENT

Cette étape doit être exécutée par le même compte d'utilisateur utilisé pour
installer EAP. Ce compte ne doit pas être un compte superutilisateur.

3. Dans ce processus, plusieurs fichiers dans le répertoire SERVER_HOME EAP seront écrasés
et vous devez laisser le processus de décompression remplacer ces fichiers. Le fichier 
SERVER_HOME /bin/product.conf en est un exemple. Après une fusion réussie, ce fichier
devra contenir la chaîne slot=bpms. Vous pouvez ouvrir ce fichier pour vérifier que les fichiers
ont été remplacés avec succès.

Dans Red Hat Enterprise Linux, vous pouvez utiliser la commande suivante pour extraire le fichier BPMS
zip et le merger dans votre répertoire de serveur correctement en une seule étape, si vous exécutez
cette commande dans le répertoire où vous avez téléchargé le fichier zip :

Exemple 3.1. La commande unzip

Au démarrage du serveur, la suite Red Hat JBoss BPM Suite sera déployée.

Pour installer un package déployable d'EAP ayant déjà été configuré, procédez ainsi :

1. Extraire le package zip déployable d'EAP que vous avez téléchargé du portail clients Red Hat
Customer Portal.

2. Décompressez l'archive zip téléchargée ; mais ne remplacez pas tous les fichiers. Faîtes
fusionner manuellement les fichiers suivants dans le répertoire SERVER_HOME.

jboss-eap-6.1/domain/configuration/* - (veuillez noter que BPMS nécessite JMS,
c'est la raison pour laquelle JMS est ajouté par défaut dans tous les profils de domain.xml
fourni dans la distribution BPMS.)

jboss-eap-6.1/standalone/configuration/* - (veuillez noter que BPMS nécessite
JMS, c'est la raison pour laquelle JMS est ajouté par défaut dans tous les fichiers de config
des profils (surtout standalone.xml et standalone-ha.xml) fournis dans la distribution
BPMS.)



unzip -u jboss-bpms-VERSION-TYPE.zip -d SERVER_HOME_PARENT_DIR

unzip -u jboss-bpms-6.0.2-redhat-7-deployable-eap6.x.zip -d 
/home/john/myServers/
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jboss-eap-6.1/modules/layers.conf

jboss-eap-6.1/bin/product.conf

3. Veillez à ce que la cible EAP n'inclue pas de déploiement ayant un nom qui risque d'entrer en
conflit. Copier le dossier jboss-eap-6.1/standalone/deployments dans le répertoire
EAP_HOME à partir de la distribution BPMS.

4. Assurez-vous bien qu'aucune couche de module EAP se prénome BPMS et copier le dossier 
jboss-eap-6.1/modules/system/layers/bpms dans le dossier EAP 6.1.1.

Rapporter un bogue

3.1.3. Définir les rôles

Avant de démarrer le serveur et de vous connecter au Business Central, vous devrez créer des comptes
utilisateur. Cette section décrit les différents rôles qui sont utilisés dans Red Hat JBoss BPM Suite :

admin : les utilisateurs ayant un rôle admin sont les administrateurs de l'application. Les
administrateurs peuvent gérer les utilisateurs, les référentiels (les créer et les cloner) et avoir un
accès total pour effectuer des changements dans l'application. Les admins ont accès à toutes
les régions du système.

developer : un développeur a accès à presque toutes les fonctionnalités et peut gérer des
règles, des modèles, des flux de processus, des formulaires et tableaux de bord. Ils peuvent
gérer le référentiel des ressources, ils peuvent créer, construire et déployer des projets et ils
peuvent même utiliser Red Hat JBoss Developer Studio pour afficher les processus. Seules
certaines fonctions administratives comme la création et le clonage d'un nouveau référentiel
sont masqués au rôle de développeur.

analyst : un rôle d'analyste a accès à toutes les fonctions de haut niveau pour modeler et
exécuter des projets. Cependant, l'accès Authoring → Administration n'est pas disponible
aux utilisateurs ayant un role d'analyste. Certaines fonctions de bas niveau qui ciblent les
développeurs, comme la vue Deployment → Artifact Repository sont cachées à ce role.
Cependant, le bouton Build & Deploy est accessible au role d'analyste quand celui-ci utilise
l'éditeur de projet.

utilisateur : l'utilisateur travaille sur les listes de tâches d'entreprise qui sont utilisées pour
l'exploitation d'un certain processus. Un utilisateur avec ce rôle peut accéder au tableau de bord
et gérer les processus.

manager : un manager est une personne qui voit un système et s'intéresse aux statistiques sur
les processus d'entreprise et la performance, les indicateurs clé de l'entreprise et autres rapports
du système. Un utilisateur avec ce rôle a accès à la BAM uniquement.

NOTE

Saisir les rôles mentionnés ci-dessus lors du processus de création d'un utilisateur.

Rapporter un bogue

3.1.4. Création des utilisateurs

Pour commencer à ajouter de nouveaux utilisateurs, vous devez exécuter le script add-user.sh sur un
système Unix ou le fichier add-user.bat sur un système Windows dans le répertoire bin EAP.
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1. Exécuter ./add-user.sh sur un système Unix ou add-user.bat sur un système Windows à partir du
répertoire bin.

2. Saisir b pour sélectionner un Utilisateur d'application à l'invite type d'utilisateur, et appuyer sur
Enter.

3. Accepter le Domaine (Realm) par défaut (ApplicationRealm): en appuyant sur Enter.

4. À l'invite du nom utilisateur, saisir un nom utilisateur et le confirmer. Par exemple : 
helloworlduser.

5. Créer le mot de passe utilisateur à l'invite du mot de passe et saisir à nouveau le mot de passe.
Par exemple : Helloworld@123.

NOTE

Le mot de passe doit comporter au moins 8 caractères et contenir des caractères
alphabétiques majuscules et minuscules (par exemple A-Z, a-z), au moins un
caractère numérique (par exemple 0-9) et au moins un caractère spécial (p. ex.
~! @ # $ % ^ * () - _ + =).

6. Entrez une liste de rôles séparée par des virgules dont l'utilisateur aura besoin sur invite de
rôles (se reporter à Section 3.1.3, « Définir les rôles »).

Les utilisateurs de Business Central doivent au moins posséder le rôle analyst, et les
utilisateurs Dashbuilder le rôle admin. Les rôles doivent être saisis sous la forme d'une liste
séparée par des virgules.

7. Confirmer que vous souhaitez ajouter l'utilisateur.

8. Saisir oui à la prochaine invite (pour activer le clustering dans le future si possible)

Rapporter un bogue

3.2. L'INSTALLATION D'UN GROUPEMENT DÉPLOYABLE STANDARD

Pour installer Red Hat JBoss BPM Suite sur Red Hat JBoss Server Web (WS) , vous devez utiliser le
package déployable générique du produit.

Pour l'installation sur WS, le package déployable générique contient le gestionnaire de transactions
supplémentaires et les bibliothèques de sécurité qui ne font pas partie de Red Hat JBoss WS.

Notez que le package déployable générique contient les archives zip suivantes :

jboss-bpms-engine.zip : les bibliothèques d'exécution d'engine prises en charge sont
nécessaires si vous intégrez le moteur dans votre application.

jboss-bpms-manager.zip : les applications web business-central.war et 
dashbuilder.war

Rapporter un bogue

3.2.1. Télécharger un package déployable standard

Pour télécharger le package Red Hat JBoss BPM Suite dans JBoss Web Server, procéder ainsi :
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1. Allez dans Red Hat Customer Portal et connectez-vous.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu déroulant Product, sélectionner BPM Suite.

4. À partir du menu déroulant Version, sélectionner la version du produit.

5. Dans le tableau, allez sur la ligne Red Hat JBoss BRMS 6.0.2 Deployable for all 
supported containers puis cliquer sur Download.

Rapporter un bogue

3.2.2. Installer un package déployable standard

Pour installer le package déployable générique, vous devez mettre en place ce qui suit après avoir
installé la plateforme sous-jacente (Red Hat JBoss WS):

Configurez le pilote de la base de données et le gestionnaire de transactions (Bitronix) (voir
Section 3.2.2.1, « Installer un gestionnaire de transactions dans Red Hat JBoss Web Server 2.0
(Tomcat 7) »).

Installez l'application Business Central : créer des utilisateurs et des rôles, et créer des
persistances (voir Section 3.2.2.2, « Installer Business Central dans Red Hat JBoss Web Server
2.0 (Tomcat 7) »).

Installer l'application Dashbuilder : créer des utilisateurs et des rôles, et créer des persistances
(voir Section 3.2.2.3, « Installer Dashbuilder dans Red Hat JBoss Web Server 2.0 (Tomcat 7) »).

Rapporter un bogue

3.2.2.1. Installer un gestionnaire de transactions dans Red Hat JBoss Web Server 2.0
(Tomcat 7)

1. Extraire le package zip déployable que vous avez téléchargé du portail Red Hat Customer
Portal. Ce package zip contient deux fichiers supplémentaires : jboss-bpms-engine.zip et 
jboss-bpms-manager.zip.

2. Extraire les contenus du fichier jboss-bpms-manager.zip dans un emplacement temporaire.
Le fichier zip contient deux dossiers d'archives d'applications web : business-central.war
et dashbuilder.war dans des formats éclatés qui se trouvent maintenant dans
l'emplacement temporaire. Renommer ces dossiers pour supprimer l'extension .war.

Copier ces deux dossiers directement dans le dossier $TOMCAT_DIR/webapps.

You should end up with two folders in exploded format : $TOMCAT_DIR/webapps/business-
central et $TOMCAT_DIR/webapps/dashbuilder.

NOTE

$TOMCAT_DIR correspond au répertoire d'accueil où se situe le serveur web.
Remplacez-le par le chemin actuel qui mène au répertoire d'accueil de votre
serveur web, ainsi : /home/john/jboss-ews-2.0/tomcat7/
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3. Extraire le dossier jboss-bpms-engine de l'archive jboss-bpms-engine.zip vers un
emplacement temporaire à partir duquel vous pourrez copier les bibliothèques dont vous avez
besoin. Ce dossier contient maintenant toutes les bibliothèques PBMS principales dans le
dossier extrait et le dossier lib.

4. Installer le gestionnaire de transactions.
Copier les bibliothèques jar du gestionnaire de transactions suivantes à partir du dossier lib
dans lequel vous venez d'extraire les bibliothèques jboss-bpms-engine vers le répertoire 
$TOMCAT_DIR/lib/ :

btm-VERSION.jar

btm-tomcat55-lifecycle-VERSION.jar

jta-VERSION.jar

slf4j-api-VERSION.jar

slf4j-ext-VERSION.jar

De plus, télécharger la bibliohtèque suivante et copier là dans le dossier $TOMCAT_DIR/lib/
également :

javax.security.jacc-api.jar

5. Installer le pilote dans votre base de données : copier le fichier jar avec le pilote de base de
données qui convient dans $TOMCAT_DIR/lib/.

NOTE

Si vous utilisez la base de données H2 intégrée, le pilote sera disponible dans 
business-central/WEB-INF/lib/.

6. Créer les fichiers de configuration du gestionnaire de transactions dans $TOMCAT_DIR/conf/ :

btm-config.properties

resources.properties (le resource.ds1.uniqueName définit le nom de la source de données
utilisée dans la définition de ressource tomcat par la suite - et notez cette valeur).

Veillez à bien changer les valeurs dans les définitions suivantes pour qu'elles correspondent
bien à votre environnement.

Exemple 3.2. Définition de source de données H2

bitronix.tm.serverId=tomcat-btm-node0
bitronix.tm.journal.disk.logPart1Filename=${btm.root}/work/btm1.t
log
bitronix.tm.journal.disk.logPart2Filename=${btm.root}/work/btm2.t
log
bitronix.tm.resource.configuration=${btm.root}/conf/resources.pro
perties

resource.ds1.className=bitronix.tm.resource.jdbc.lrc.LrcXADataS
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Exemple 3.3. Définition de source de données MySQL 5.5

Exemple 3.4. Définition de source de données DB2 de Type 4

Exemple 3.5. Définition de source de données Oracle

Exemple 3.6. Définition de source de données Microsoft SQL Server

ource
resource.ds1.uniqueName=jdbc/jbpm
resource.ds1.minPoolSize=10
resource.ds1.maxPoolSize=20
resource.ds1.driverProperties.driverClassName=org.h2.Driver
resource.ds1.driverProperties.url=jdbc:h2:file:~/jbpm
resource.ds1.driverProperties.user=sa
resource.ds1.driverProperties.password=
resource.ds1.allowLocalTransactions=true

resource.ds1.className=com.mysql.jdbc.jdbc2.optional.MysqlXADat
aSource
resource.ds1.uniqueName=jdbc/jbpm
resource.ds1.minPoolSize=0
resource.ds1.maxPoolSize=10
resource.ds1.driverProperties.URL=jdbc:mysql://localhost:3306/s
ampledb
resource.ds1.driverProperties.user=dbuser
resource.ds1.driverProperties.password=dbpassword
resource.ds1.allowLocalTransactions=true

resource.ds1.className=com.ibm.db2.jcc.DB2Driver
resource.ds1.uniqueName=jdbc/jbpm
resource.ds1.minPoolSize=0
resource.ds1.maxPoolSize=10
resource.ds1.driverProperties.URL=jdbc:db2://localhost:50000/sa
mpledb
resource.ds1.driverProperties.user=dbuser
resource.ds1.driverProperties.password=dbpassword
resource.ds1.allowLocalTransactions=true

resource.ds1.className=oracle.jdbc.xa.client.OracleXADataSource
resource.ds1.uniqueName=jdbc/jbpm
resource.ds1.minPoolSize=0
resource.ds1.maxPoolSize=10
resource.ds1.driverProperties.URL=jdbc:oracle:thin:@//localhost
:1521/bpms 
resource.ds1.driverProperties.user=dbuser
resource.ds1.driverProperties.password=dbpassword
resource.ds1.allowLocalTransactions=true
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7. Installez le listener de gestionnaire de transactions dans $TOMCAT_DIR/conf/server.xml
pour démarrer et stopper Bitronix au démarrage et à la fermeture du conteneur :

Ajouter l'élément suivant comme dernier élément <Listener> dans l'élément <Server> :

8. Définir la propriété système btm.root et l'emplacement où le fichier de config bitronix se trouve :

Dans $TOMCAT_DIR/bin/, créez le fichier setenv.sh avec le contenu suivant :

Donnez les permissions « execute » au fichier si applicable. 
org.jbpm.designer.perspective est défini sur RuleFlow pour que la perspective par
défaut du designer puisse être RuleFlow et non Full.

IMPORTANT

Dans les systèmes Microsoft Windows, remplacer la valeur $CATALINA_HOME
du contenu du fichier par le nom de la variable d'environnement équivalente ou
utiliser le chemin complet et ajouter les valeurs dans le fichier setenv.bat
comme dans l'exemple suivant :

Rapporter un bogue

3.2.2.2. Installer Business Central dans Red Hat JBoss Web Server 2.0 (Tomcat 7)

Pour installer Business Central, procédez ainsi :

resource.ds1.className=com.microsoft.sqlserver.jdbc.SQLServerDr
iver
resource.ds1.uniqueName=jdbc/jbpm
resource.ds1.minPoolSize=0
resource.ds1.maxPoolSize=10
resource.ds1.driverProperties.URL=jdbc:sqlserver://localhost:14
33;databaseName=bpms;
resource.ds1.driverProperties.user=dbuser
resource.ds1.driverProperties.password=dbpassword
resource.ds1.allowLocalTransactions=true

<Listener 
className="bitronix.tm.integration.tomcat55.BTMLifecycleListener" />

CATALINA_OPTS="-Xmx512M -XX:MaxPermSize=512m -
Dbtm.root=$CATALINA_HOME -
Dbitronix.tm.configuration=$CATALINA_HOME/conf/btm-config.properties 
-Dorg.jbpm.designer.perspective=RuleFlow"

set "CATALINA_OPTS=-Xmx512M -XX:MaxPermSize=512m -
Dbtm.root=C:/Tomcat -
Dbitronix.tm.configuration=C:/Tomcat/conf/btm-
config.properties -
Dorg.jbpm.designer.perspective=RuleFlow"
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1. Installer une Valve pour que l'application web de Web Central puisse télécharger les utilisateurs
créés dans Tomcat :

a. Définir les utilisateurs et les roles dans $TOMCAT_DIR/conf/tomcat-users.xml. Notez
que Business Central nécessite que les utilisateurs aient les roles admin et/ou analyst
(pour obtenir plus d'informations sur les définitions de role ou d'utilisateur, veuillez consulter
la documentation Tomcat 7).

La liste de programme ci-dessous est un exemple qui montre comment ces deux rôles
peuvent être ajoutés et comment affecter ces rôles à un utilisateur nommé bpmsadmin.

b. Copier kie-tomcat-integration-VERSION.jar de 
$TOMCAT_DIR/webapps/business-central/WEB-INF/lib/ dans 
$TOMCAT_DIR/lib/.

c. Copier jaxb-api-VERSION.jar de $TOMCAT_DIR/webapps/business-
central/WEB-INF/lib/ dans $TOMCAT_DIR/lib/.

d. Dans $TOMCAT_DIR/conf/server.xml, ajouter la déclaration de Valve Tomcat dans
l'élément <hôte> qui convient :

e. Dans $TOMCAT_DIR/webapps/business-central/WEB-INF/web.xml, dé-
commenter les entrées comprenant des commentaires TOMCAT-JEE-SECURITY.

f. Installer la source d'authentification de tomcat : dans le répertoire 
$TOMCAT_DIR/webapps/business-central/WEB-INF/classes/META-
INF/services/, renommer les fichiers suivants : 
org.uberfire.security.auth.AuthenticationSource en 
org.uberfire.security.auth.AuthenticationSource-ORIGIN et 
org.uberfire.security.auth.AuthenticationSource-TOMCAT-JEE-SECURITY
en org.uberfire.security.auth.AuthenticationSource:

g. Dans $TOMCAT_DIR/webapps/business-central/WEB-INF/beans.xml,
décommenter JAASUserGroupInfoProducer et commenter 

  <role rolename="admin"/>
  <role rolename="analyst" />
  <user username="bpmsadmin" password="P@ssw0rd" 
roles="admin,analyst"/>

<Valve className="org.kie.integration.tomcat.JACCValve" />

# Example command if you run this from $TOMCAT_DIR/webapps 
directory 
$ mv business-central/WEB-INF/classes/META-
INF/services/org.uberfire.security.auth.AuthenticationSource 
business-central/WEB-INF/classes/META-
INF/services/org.uberfire.security.auth.AuthenticationSource-
ORIGIN
$ mv business-central/WEB-INF/classes/META-
INF/services/org.uberfire.security.auth.AuthenticationSource-
TOMCAT-JEE-SECURITY business-central/WEB-INF/classes/META-
INF/services/org.uberfire.security.auth.AuthenticationSource
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org.jbpm.kie.services.cdi.producer.DefaultUserGroupInfoProducer
(optionnel). La partie alternatives de ce fichier devra ressembler à ceci :

2. Si vous utilisez une source de données autre que la valeur par défaut fournie par la base de
données sous-jacente de H2, vous aurez besoin d'installer une persistance. Si vous utilisez la
base de données de H2 par défaut, vous pouvez alors ignorer le reste des étapes de cette
procédure.

Dans cette procédure, vous configurez une source de données avec le nom JNDI 
jdbc/myDatasource défini dans uniqueName=jdbc/jbpm du fichier bitronix 
resources.properties auparavant (pour l'option MySQL).

a. Dans business-central/META-INF/context.xml, remplacer le nom JNDI de la
source de données de l'élément <Resource>. L'attribut uniqueName se rapporte à la
propriété resource.ds1.uniqueName définie dans resources.properties :

b. Dans business-central/WEB-INF/web.xml, remplacer le nom JNDI de la source de
données de l'élément >res-ref-name< par le nom de votre source de données :

c. Modifier business-central/WEB-INF/classes/META-INF/persistence.xml.

Dans ce fichier, modifier le nom du dialecte hibernate utilisé dans votre base de données, si
vous utilisez une autre base de données que H2. Le code ci-dessous montre les
informations de la base de données d'origine de persistence.xml :

Cette information peut être mise à jour de la manière suivante (comme démontré dans la
base de données MySQL ci-dessous) :

  <alternatives>
    <!--    
<class>org.jbpm.kie.services.cdi.producer.DefaultUserGroupInfoPro
ducer</class> -->
    <!-- uncomment JAASUserGroupInfoProducer when using JEE 
security on Tomcat -->
    
<class>org.jbpm.kie.services.cdi.producer.JAASUserGroupInfoProduc
er</class>
  </alternatives>      

<Resource name="jdbc/myDatasource" uniqueName="jdbc/jbpm" 
auth="Container" removeAbandoned="true" 
factory="bitronix.tm.resource.ResourceObjectFactory" 
type="javax.sql.DataSource"/>

<resource-ref>
        <description>Console DS</description>
        <res-ref-name>jdbc/myDatasource</res-ref-name>
        <res-type>javax.sql.DataSource</res-type>
        <res-auth>Container</res-auth>
</resource-ref>

<property name="hibernate.dialect" 
value="org.hibernate.dialect.H2Dialect"/>
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NOTE

Le dialecte de DB2 est org.hibernate.dialect.DB2Dialect, pour DB2
dans AS/400, c'est org.hibernate.dialect.DB2400Dialect, Oracle,
c'est org.hibernate.dialect.Oracle10gDialect et pour le Microsoft
SQL Server, c'est org.hibernate.dialect.SQLServerDialect.

d. Modifier le fichier business-central/WEB-INF/classes/META-
INF/persistence.xml de façon à ce que le moteur de process BPMS puisse utiliser la
nouvelle base de données.

Le code ci-dessous démontre les informations de la source de données d'origine pour 
persistence.xml :

Modifier cette valeur pour qu'elle corresponde à la valeur de la source de données définie
plus tôt :

3. Vous pouvez démarrer dès maintenant le JBoss Web Server pour vous connecter à Business
Central.

a. Exécuter startup.sh dans le répertoire $TOMCAT_HOME/bin.

b. Naviguez vers http://localhost:8080/business-central dans un navigateur web.

c. Connectez-vous avec le nom d'utilisateur et le mot de passe donnés dans le fichier 
tomcat-users.xml où vous avez défini les rôles d'utilisateur.

Rapporter un bogue

3.2.2.3. Installer Dashbuilder dans Red Hat JBoss Web Server 2.0 (Tomcat 7)

Pour installer Dashbuilder dans Red Hat JBoss Web Server, procéder ainsi :

1. Définir les utilisateurs et les roles dans $TOMCAT_DIR/conf/tomcat-users.xml. Notez que
Dashbuilder nécessite que les utilisateurs aient les roles admin et/ou analyst. Si vous avez
déjà défini ces utilisateurs plus tôt dans Business-Central, vous n'avez pas besoin de les définir
à nouveau.

2. Activer un seul sign-on entre Dashbuilder et Business Central en décommentant les lignes
suivantes : $TOMCAT_DIR/conf/server.xml :

<property name="hibernate.dialect" 
value="org.hibernate.dialect.MySQLDialect"/>

<jta-data-source>java:comp/env/jdbc/jbpm</jta-data-source>

<jta-data-source>java:comp/env/jdbc/myDatasource</jta-data-
source>

./startup.sh

<Valve className="org.apache.catalina.authenticator.SingleSignOn" />
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3. Comme avec l'installation Business Central, si vous utilisez une base de données autre que la
base de données par défaut et H2 intégrée, vous devrez installer une persistance.

Dans cette procédure, vous configurez une source de données avec le nom JNDI 
jdbc/dashbuilderDS défini dans uniqueName=jdbc/jbpm dans le fichier bitronix 
resources.properties :

a. Dans dashbuilder/META-INF/context.xml, remplacer le nom JNDI de la source de
données de l'élément <Resource>. L'attribut uniqueName se rapporte à la propriété
resource.ds1.uniqueName définie dans resources.properties :

NOTE

Suivant votre base de données, vous souhaiterez peut-être définir d'autres
propriétés. Par exemple, dans un envirionnement Oracle, cette entrée peut
ressembler au listing suivant.

b. Dans dashbuilder/WEB-INF/web.xml, ajouter le nom JNDI de la source de données de
l'élément >res-ref-name< par le nom de votre source de données :

c. Dans dashbuilder/META-INF/context.xml, définir l'usine de transactions :

d. Mettre à jour le nom JNDI de la base de données dans dashbuilder/WEB-
INF/etc/hibernate.cfg.xml de l'élément <session-factory> :

<Resource name="jdbc/dashbuilderDS" uniqueName="jdbc/jbpm" 
auth="Container" removeAbandoned="true" 
factory="bitronix.tm.resource.ResourceObjectFactory" 
type="javax.sql.DataSource"/>

<Resource name="jdbc/jbpm" uniqueName="jdbc/jbpm" 
auth="Container"  removeAbandoned="true" 
factory="bitronix.tm.resource.ResourceObjectFactory" 
type="javax.sql.DataSource" username="username" 
password="password"  
driverClassName="oracle.jdbc.xa.client.OracleXADataSou
rce" url="jdbc:oracle:thin:YOUR-URL:1521:YOUR-DB" 
maxActive="8" />

<resource-ref>
    <description>Dashboard Builder Datasource</description>
    <res-ref-name>jdbc/dashbuilderDS</res-ref-name>
    <res-type>javax.sql.DataSource</res-type>
    <res-auth>Container</res-auth>
</resource-ref>

 <Transaction 
factory="bitronix.tm.BitronixUserTransactionObjectFactory"/>

<property 
name="connection.datasource">java:/comp/env/jdbc/dashbuilderDS</p
roperty>
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4. Redémarrer le serveur web pour appliquer les changements. Une fois redémarré, vous pourrez
vous rendre dans Dashbuildre à partir de Business Central ou directement via : 
http://localhost:8080/dashbuilder.

Rapporter un bogue

3.3. DÉMARRAGE DU SERVEUR

Si vous avez installé BPMS par le programme d'installation ou par le package d'installation EAP 6, vous
pouvez maintenant démarrer votre serveur dans un des deux modes.

NOTE

Si vous avez installé BPMS en utilisant la version générique déployable sur le serveur
Red Hat Java Web Server, les instructions de téléchargement et d'installation contiennent
les instructions de démarrage du serveur. Vous pouvez ignorer la discussion qui suit.

Le script de démarrage par défaut, standalone.sh qui fait partie de Red Hat JBoss BRMS Suite est
optimisé dans un souci de performance. Pour exécuter votre serveur en mode de performance, suivez
ces instructions :

1. Sur ligne de commande, déplacez-vous dans le répertoire $SERVER_HOME/bin/.

2. Dans un environnement Unix, exécuter :

./standalone.sh

Dans un environnement Windows, exécuter :

./standalone.bat

Red Hat JBoss BRMS Suite est aussi fourni avec un script séparé, standalone-secure.sh optimisé
pour la sécurité. Ce script applique une politique de sécurité par défaut qui protège contre une
vulnérabilité de sécurité connue.

NOTE

Il est conseillé que l'environnement de production utilise le script standalone-
secure.sh.

AVERTISSEMENT

L'utilisation d'un gestionnaire de sécurité impose une baisse sensible de la
performances dont vous devez être conscient. Le compromis entre sécurité et
performance s'impose en tenant compte des circonstances individuelles. Voir
Section 3.4, « Java Security Manager et Gestion de performance ».


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Pour exécuter le serveur en mode sécurisé avec ce script, vous devrez faire ce qui suit : 

1. Sur ligne de commande, déplacez-vous dans le répertoire $SERVER_HOME/bin/.

2. Dans un environnement Unix, exécuter :

./standalone-secure.sh

Dans un environnement Windows, exécuter :

./standalone-secure.bat

Rapporter un bogue

3.4. JAVA SECURITY MANAGER ET GESTION DE PERFORMANCE

Tel que mentionné précédemment, en activant JSM, le gestionnaire de sécurité Java, à sandbox,
l'évaluation de scripts MVEL dans BPMS ajoute une charge sur la performances dans des
environnements à forte charge. On doit conserver à l'esprit les environnements et les marqueurs de
performance lorsqu'on déploie une application BPMS. Utilisez les instructions suivantes pour déployer
des applications BPMS sécurisées et performantes.

Dans des environnements de charge élevée où la performance est critique, il est recommandé
de seulement déployer des applications qui ont été développées sur d'autres systèmes et qui ont
été adéquatement évaluées. Il est également recommandé de ne pas créer des utilisateurs avec
le rôle d'analyste sur de tels systèmes. Si ces précautions sont respectées, il est sécuritaire de
laisser JSM désactivé sur ces systèmes afin d'éviter toute dégradation de performance.

Dans les environnements de test et de développement sans charges élevées ou dans des
environnements où la règle et le processus de création sont exposés à des réseaux externes, il
est recommandé d'avoir JSM activé afin d'obtenir une meilleure sécurité d'évaluation
correctement isolée (sandboxed) de MVEL.

Autoriser les utilisateurs ayant un rôle d'analyste à se connecter dans la console Business Central avec
JMS désactivé n'est pas sécurisé, ni recommandé.

Rapporter un bogue
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CHAPITRE 4. CONNECTEZ-VOUS À BUSINESS CENTRAL
Connectez-vous à Business Central une fois que le serveur aura démarré.

1. Naviguer dans http://localhost:8080/business-central via navigateur web. Si l'interface utilisateur
est configurée pour exécuter à partir d'un nom de domaine, substituer localhost par le nom de
domaine. Par exemple http://www.example.com:8080/business-central.

2. Connectez-vous à l'aide des informations d'identification qui ont été créées lors de l'installation.
Par exemple: User = helloworlduser et mot de passe = Helloworld@123.

Rapporter un bogue
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CHAPITRE 5. PROJET HELLO WORLD
Pour démontrer les fonctionnalités de base de Red Hat JBoss BPM Suite, ce chapitre vous montrera
comment définir le projet Hello World avec un business process Hello World. Le business process
se contentera d'afficher le message Hello World! et de terminer l'exécution.

Vous devrez procéder ainsi :

1. Créer un référentiel Hello World dans le référentiel Artifact.

2. Créer le projet Hello World avec la définition de business process HelloWorld.

3. Modéliser la logique de processus Hello World dans le business process à l'aide de l'outil
concepteur de processus graphique.

4. Générer et déployer le projet dans le moteur d'exécution local.

5. Exécuter le processus Hello World

6. Surveillez l'exécution du processus.

Rapporter un bogue

5.1. CRÉATION D'UNE STRUCTURE DE RÉFÉRENTIEL

Tous les actifs de l'entreprise vivent dans des référentiels qui se trouvent dans des Unités
d'organisation, qui sont des répertoires dans le référentiel Artifact. Par défaut, le référentiel artifact ne
contient pas n'importe quelles unités d'organisation. Donc, pour pouvoir créer votre propre business
process, comme un processus d'entreprise, vous devez créer une unité d'organisation dans le référentiel
Artifact et un référentiel (Git) dedans. Le référentiel peut contenir votre Projet. Un projet peut contenir une
structure de package arbitraire, qui permet de structurer son contenu dans la structure logique du «
répertoire ». Un package peut contenir vos ressources d'entreprise (pour plus d'informations sur le
référentiel Artifact, consulter le Guide utilisateur de Red Hat JBoss BPMS)

Pour créer la structure du référentiel, procédez ainsi :

1. Ouvrir Business Central dans votre navigateur web (en cas d'exécution locale
http://localhost:8080/business-central) et connectez-vous en tant qu'utilisateur avec le rôle 
admin (helloworlduser).

2. Créer une unité organisationnelle dans le référentiel Artifact :

a. Aller dans Authoring → Administration.

b. Dans le menu Perspective, cliquer sur Organizational Units → Manage Organizational
Units.

c. Dans la vue Organizational Unit Manager, cliquer sur Add.

Dans la boîte de Add New Organizational Unit affichée, définir les propriétés d'unité
et cliquer sur le bouton OK:

Nom : helloworld

Propriétaire : helloworlduser
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3. Créer un nouveau référentiel dans l'unité organisationnelle helloworld :

a. Aller dans Authoring → Administration.

b. Dans le menu perspective, cliquer sur Repositories → New repository.

c. Dans la boîte de dialogue Create Repository affichée, définir les propriétés du
référentiel :

Nom du référentiel : helloworldrepo

Unité organisationnelle : helloworld

4. Aller dans Authoring → Project Authoring.

5. Dans Project Explorer qui se trouve dans la boîte d'unité organisationnelle, sélectionner 
helloworld, et dans la zone déroulante du référentiel, sélectionner helloworldrepo.

Figure 5.1. Sélectionner le référentiel helloworldrepo qui se trouve dans le groupe
organisationnel helloworld de Project Explorer

6. Créer un projet dans le référentiel helloworld :

a. Dans le menu perspective, cliquer sur New Item → Project.

b. Dans la boîte de dialogue Create new affichée, définir les propriétés du Projet :

Nom du projet (nom du projet): HelloWorld

Chemin : default://master@helloworldrepo/

c. Dans la boîte de dialogue New Project Wizard, définir les propriétés maven du projet.
Appuyer sur la touche Enter après chaque entrée.

ID Group : org.jbpm

ID Artifact : HelloWorld

ID Version : 1.0
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d. Cliquer sur Terminé.

Rapporter un bogue
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CHAPITRE 6. PROCESSUS HELLO WORLD
Dans ce chapitre, nous allons continuer avec l'exemple Hello World et créer un processus d'un bout à
l'autre pour montrer la création d'un processus Hello World de base.

Rapporter un bogue

6.1. CRÉATION D'UN BUSINESS PROCESS

Pour créer une nouvelle définition de Business Process, procédez ainsi :

1. Afficher la perspective Project Authoring (Authoring → Project Authoring).

2. Dans la vue de Project Explorer sur la gauche, sélectionner l'unité organisationnelle 
helloworld, le référentiel helloworldrepo, le projet HelloWorld, et le package org.jbpm :
cela définit l'emplacement du référentiel Artifact, où vous pourrez créer votre définition de
Business Process.

NOTE

Assurez-vous de bien sélectionner le package org.jbpm. Si vous sélectionnez le
mauvais package, le déploiement échouera.

3. Dans le menu perspective, cliquez sur New Item → Business Process et définissez les
informations de Process :

Saisir le nom de ressource en tant que HelloWorld.

4. Cliquez sur Valider.

Le Process Designer et le canvas de la définition de Process créée s'ouvre.

Rapporter un bogue

6.2. MODÉLISATION D'UN BUSINESS PROCESS

Après avoir créé la définition d'un business process, vous pouvez penser à la conception du business
process dans le Business Process Designer : ce concepteur de business process doit être ouvert dans
un onglet sur la droite. Si vous avez fermé l'onglet, dans Project Explorer, cliquez sur HelloWorld sous
Business Processes pour ré-ouvrir le Business Process Designer. Assurez-vous de sélectionner le
bon paquet (org.jbpm.helloworld). Pour concevoir un contenu de processus, procédez comme suit :

1. Étendre la palette Object Library avec les éléments de processus : cliquer sur le bouton à

deux flèches (  ) qui se trouve en haut et à gauche de l'onglet de création de Business
Process.

2. Un élément Start Event apparait sur le canvas.

3. Cliquer sur l'élément Start Event : les éléments de l'éditeur de liens rapides apparaisseront

autour du nœud. Cliquer sur l'icône de tâche (  ) pour créer un Flux de séquence sortant et
un élément de travail (Task) associé au Start Event c-a-d à l'événement de démarrage.
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4. Créer un événement Timer Event : de la palette, choisir et faire glisser le Timer sous Catching 
Intermediate Events (capturer les événements intermédiaires) et connectez la tâche (Task)
à l'élément Timer à l'aide du menu de l'éditeur de liens rapides.

5. Créer l'élément End Event relié à l'élément Timer Event (à l'aide de la fonctionnalité de l'éditeur
de liens rapides ou en le faisant glisser de la palette).

Figure 6.1. Ébauche du processus HelloWorld

Rapporter un bogue

6.3. DÉFINIR DES PROPRIÉTÉS D'ÉLÉMENT

Maintenant, vous devez définir les propriétés d'élément :

1. Clique la flèche double (  ) dans le coin en haut et à droite pour étendre l'onglet 
Properties.

2. Clique n'importe où sur le canvas. L'onglet Properties affiche les propriétés du processus 
HelloWorld . Les propriétés requises sont pré-définies; cependant, vous pouvez en changer
les valeurs si nécessaire.

3. L'élément Start et l'élément End n'ont que des propriétés optionnelles. Cependant, on doit
définir le type et les propriétés spécifiques des éléments Task : cliquer sur l'élément Task et
définir les propriétés requises :

Nom: ScriptTask

Tyoe de tâche: Script

Script Language: java

Script: System.out.println("Hello World!");

Cliquez sur Valider.

Vous avez défini une tâche qui produira un script à exécuter. Le script est défini dans Java et
exécute la méthode System.out.println ("Hello World!");, ce qui signifie qu'il écrira 
Hello World! sur la sortie standard du serveur (par défaut, la sortie standard du serveur est
la console sur laquelle le serveur a été démarré).

4. Vous devez encore définir les propriétés de l'événement Timer pour que le processus attende
au moment de l'exécution, ainsi vous pourrez en inspecter l'exécution : cliquez sur l'élément
Timer et de définir les propriétés requises

Time Cycle Language: Cron
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Duration: 1m et appuyer sur Enter.

Le processus devra donc attendre 1 minute dans l'événement Timer avant d'exécuter la
tâche de Script.

5. Donnez un nom à un événement de minuterie par l'intermédiaire des propriétés, puis

sauvegarde votre processus : ouvrir le menu Save (  ) et cliquer sur Save.

6. Cliquer sur le bouton (  ) sur la barre d'outils du Process Designer avec le processus pour
vous assurer que le processus soit bien valide. Le contour d'un élément contenant une ou
plusieurs erreurs de validation tourne orange (se référer à la Red Hat JBoss BPMS User Guide
pour obtenir des informations sur la fonctionnalité de validation).

Pour obtenir des informations supplémentaires sur les éléments de processus et leurs propriétés, voir
JBoss BPMS User Guide.

Rapporter un bogue

6.4. GÉNÉRATION ET DÉPLOIEMENT

Avant de pouvoir instancier ceci, exécuter votre processus Hello World, vous aurez besoin de
construire le projet dans son ensemble et le déployer dans le serveur d'exécution:

1. Dans le menu principal de Business Central, aller dans Authoring → Project Authoring.

2. Dans Project Explorer, chercher le projet Hello World.

3. Ouvrir le project dans l'éditeur du project  : dans le menu perpective, cliquer sur Tools →
Project Editor.

4. Vérifier que les bonnes informations de project soient affichées dans Project Screen et
cliquer sur le bouton Build & Deploy qui se trouve dans le coin en haut et à gauche de la
vue Project View.

Figure 6.2. Éditeur de projet avec des propriétés de projet helloWorld
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Une notification verte apparaît dans la partie supérieure de l'écran pour vous informer que le projet a été
généré et a été déployé dans le serveur d'exécution et est disponible pour l'instanciation.

Rapporter un bogue

6.5. INSTANCIATION D'UN BUSINESS PROCESS

Pour créer une nouvelle définition du processus Hello World, procédez ainsi :

1. Cliquer sur Process Management → Process Definitions dans le menu principal.

2. Sous l'onglet Process Definitions affiché, trouvez l'emplacement de Hello World. Vous
devrez peut-être cliquer sur Refresh pour que le déploiement s'affiche dans la liste

3. Cliquer sur le bouton Start(  ) qui se trouve près de l'entrée Définition de processus et

dans la boîte de dialogue Form, cliquer sur le bouton (  ) pour confirmer que vous souhaitez
instancier le processus.

Le processus est instancié par l'utilisateur actuellement connecté en tant que le propriétaire de
processus et le formulaire de processus s'affiche (le formulaire peut servir à demander des
entrées d'utilisateur sur l'instanciation de processus si défini; consultez Red Hat JBoss BPMS
User Guide)

La vue Process Instance Details s'affiche avec des détails sur l'instance de processus déjà
commencé. Le message Hello World s'affiche dans la sortie standard, généralement qui correspond
à l'émulateur de terminal dans lequel le serveur a été démarré. L'instance de processus attend ensuite
sur l'événement Timer. Cliquez sur Views - Process Model pour connaître l'état actuel d'exécution.

Figure 6.3. Diagramme d'exécution de HelloWorld en temps réel: l'événement Timer en cours
d'exécution

Rapporter un bogue

6.6. ABANDON DE BUSINESS PROCESS
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Pour l'instant, une instance du Process HelloWorld est en cours sur le serveur d'exécution. Vous
pouvez vérifier dans la vue Process Instances : pour afficher la vue, aller dans Process
Management → Process Instances.

À partir de là, vous pourrez apercevoir les détails d'une instance de processus en utilisant le bouton

Details (  ) et en effectuant des actions administratives de base, comme envoyer un signal à une

instance de processus (  ) et l'abandonner (  ).

Comme l'instance de processus HelloWorld est en attente de l'événement Timer Event, l'abonner :

cliquer sur (  ) sur la ligne qui contient l'information d'instance de processsus HelloWorld :
l'instance disparaîtra de la liste des instances de processus actif et apparaîtra dans la liste des instances
Aborted abandonnées.

Figure 6.4. Instances de processus abandonnées, y compris l'instance de processus HelloWorld

Rapporter un bogue
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CHAPITRE 7. RÈGLE MÉTIER HELLO WORLD
Comme BPMS est fourni avec BRMS intégré, ce chapitre donne une introduction sur la façon dont les
règles métier fonctionnent et s'intègrent dans BPMS.

Vous ajouterez une nouvelle tâche, une tâche de règle métier, dans le processus HelloWorld, qui
vérifiera une règle métier de groupe de règles métier en particulier.

Notez qu'il s'agit d'un cas simple d'intégration et en production, vous risquez d'utiliser un concept et des
techniques plus avancées, comme des tables de décisions. Pour plus d'informations sur les règles
métier et BRMS, voir le guide Red Hat JBoss BRMS User Guide

Rapporter un bogue

7.1. CRÉATION D'UNE RÈGLE MÉTIER

Les règles métier sont définies sous forme d'énoncés si-alors : quand un énoncé est true, alors quelque
chose a lieu (par exemple si une personne a plus de 18 ans, elle peut accéder à un contenu spécifique).
Les règles de contenu sont stockées dans les fichiers DRL.

Pour définir la règle de métier helloworldrule dans le projet HelloWorld, procédez ainsi :

1. Dans Project Explorer, sélectionner l'unité organisationnelle helloworld, le référentiel 
helloworldrepo, le projet HelloWorld, et le package default.

NOTE

Assurez-vous de bien sélectionner le package default. Si vous sélectionnez le
mauvais package, le déploiement échouera.

2. Créer le fichier DRL :

a. Dans le menu perspective, cliquer sur New Item → DRL file.

b. Dans la boîte de dialogue Create New, définir le nom de la ressource en tant que 
helloworldrule et vérifier que le chemin de destination soit bien 
default://master@helloworldrepo/HelloWorld/src/main/resources.

c. Cliquez sur Valider.

3. Dans l'éditeur DRL qui affiche le fichier helloworldrule.drl, définir la règle :

Cette règle ne définit aucune condition (Si), c'est à dire qu'elle sera toujours sur true par défaut
quand on l'appelle à exécution, et la phrase Hello World! s'affichera.

4. Cliquer sur le bouton Save.

rule "helloworldrule"
ruleflow-group "helloworldgroup"
when 
then
 System.out.println("Hello World!");
end
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5. Une invite Save this item apparaît. Saisir Check-in comment et cliquer sur Save.

NOTE

Le commentaire d'enregistrement correspond à une description courte du genre
de changement que vous venez d'effecteur et doit être saisi à chaque fois qu'une
ressource est sauvegardée.

Rapporter un bogue

7.2. CRÉATION D'UNE TÂCHE DE RÈGLE MÉTIER

Une tâche de règle métier est une tâche qui envoie des règles appartenant à un certain groupe de
règles.

Pour ajouter une tâche de règle métier à votre processus, procédez ainsi :

1. Ouvrir votre Business Process dans le Process Designer : dans Project Explorer,
sélectionner le projet HelloWorld, le package org.jbpm, cliquer sur BUSINESS PROCESSES et
cliquer sur le processus HelloWorld.

NOTE

Assurez-vous de bien sélectionner le package org.jbpm. Si vous sélectionnez le
mauvais package, le déploiement échouera.

2. Dans le concepteur de Business Process qui s'affiche avec le processus helloworld, étendre la
palette Object Library avec les éléments de processus : cliquer sur le bouton à deux

flèches (  ) qui se trouve en haut et à gauche de l'onglet de création de Business Process.

3. Étendre le menu Tasks, et glisser-déplacer la tâche de règle de métier dans le canvas qui se
trouve sur la droite.

Ajuster les connexions de flux pour intégrer la tâche au flux de travail.

4. Sélectionner la tâche de règle métier et définir ses propriétés dans le panneau Properties :

Nom : BusinessRule

Groupe de règles : helloworldgroup

La propriété Ruleflow Group définit le groupe de règles qui doit être déclenché lorsque la
tâche est en cours d'exécution. Dans cet exemple, une seule règle, la règle 
helloworldrule définie dans le helloworldrule.drl, est définie dans le groupe 
helloworldgroup.
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Figure 7.1. Le processus helloworld et la tâche de règle métier et ses propriétés

5. Cliquer sur le bouton de sauvegarde pour enregistrer les modifications.

Rapporter un bogue

7.3. GÉNÉRATION ET DÉPLOIEMENT

Générer le projet complet et déployez-le dans le serveur d'exécution :

1. Dans le menu principal de Business Central, aller dans Authoring → Project Authoring.

2. Dans Project Explorer, chercher le projet Hello World.

3. Ouvrir le project dans l'éditeur de project  : dans le menu perpective, cliquer sur Tools →
Project Editor.

4. Vérifier que les bonnes informations de project soient affichées dans Project Screen et
cliquer sur le bouton Build & Deploy qui se trouve dans le coin en haut et à gauche de la
vue Project View.

Figure 7.2. Éditeur de projet avec des propriétés de projet helloWorld

Une notification verte apparaît dans la partie supérieure de l'écran pour vous informer que le projet a été
généré et a été déployé dans le serveur d'exécution, maintenant prêt à être instancié. Noter que la
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version précédente du déploiement helloWorld est remplacée par la nouvelle version avec la tâche de
règle d'entreprise (Business Rule Task). Pour garder les deux déploiements, changer le numéro de
version du projet dans l'éditeur de projet.

Rapporter un bogue

7.4. INSTANCIATION D'UN BUSINESS PROCESS

Pour créer une nouvelle définition du processus Hello World, procédez ainsi :

1. Cliquer sur Process Management → Process Definitions dans le menu principal.

2. Sous l'onglet Process Definitions affiché, trouvez l'emplacement de Hello World. Vous
devrez peut-être cliquer sur Refresh pour que le déploiement s'affiche dans la liste

3. Cliquer sur le bouton Start(  ) qui se trouve près de l'entrée Définition de processus et

dans la boîte de dialogue Form, cliquer sur le bouton (  ) pour confirmer que vous souhaitez
instancier le processus.

Le processus est instancié par l'utilisateur actuellement connecté en tant que propriétaire de
processus et le formulaire de processus s'affiche (le formulaire peut servir à demander des
entrées d'utilisateur sur l'instanciation de processus si défini; consultez Red Hat JBoss BPMS
User Guide)

La vue Process Instance Details s'affiche avec des détails sur l'instance de processus déjà
commencé. Le message Hello World s'affiche dans la sortie standard deux fois, généralement qui
correspond à l'émulateur de terminal dans lequel le serveur a été démarré. L'instance de processus
attend ensuite sur l'événement Timer. Cliquez sur Views - Process Model pour connaître l'état
actuel d'exécution.

Figure 7.3. Diagramme d'exécution de HelloWorld en temps réel : l'événement Timer en cours
d'exécution

Rapporter un bogue
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CHAPITRE 8. BAM

8.1. ACCÉDER À RED HAT JBOSS BPM SUITE DASHBUILDER

Dashbuilder est l'interface utilisateur basée web de Red Hat JBoss BPM Suite pour le Business Activity
Monitoring. Pour accéder au Dashbuilder à partir de Business Central, aller dans Dashboards →
Process & Task Dashboards.

Le tableau de bord qui s'affiche fournit des statistiques sur les données de runtime sélectionnées à
gauche. Vous pouvez créer votre propre tableau de bord dans le Dashbuilder. Pour cela, afficher le
Dashbuilder en cliquant sur Dashboards → Business Dashboards.

Rapporter un bogue

8.2. MONITORING DES INSTANCES

Le Dashbuilder fournit un tableau de bord qui vous permet de surveiller le statut des données du runtime
(Instances de processus et Tâches) de votre moteur d'exécution.

Pour voir ces données, aller dans Dashboards → Process & Task Dashboard.

Figure 8.1. Tableau de bord de tâches et de processus

Dans le panneau de gauche, vous pourrez sélectionner une entité pour laquelle aller afficher les
statistiques. Les chartes et les données sur la droite sont mises à jour en fonction.

Rapporter un bogue
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CHAPITRE 9. RED HAT JBOSS DEVELOPER STUDIO
Red Hat JBoss Developer Studio est l'environnement de développement intégré de JBoss (IDE) basé
sur Eclipse et disponible à partir du portail de support client de Red Hat à https://access.redhat.com.
JBoss Developer Studio fournit des plug-ins avec des outils et des interfaces pour Red Hat JBoss BRMS
et Red Hat JBoss BPM Suite. Ces plugins sont basés sur la version communautaire de ces produits.
Ainsi, le plugin de BRMS s'appelle le plugin Drools et le plugin BPM Suite s'appelle le plugin jBPM.

Voir la documentation Red Hat JBoss Developer Studio pour obtenir les instructions d'installation et de
configuration.

Rapporter un bogue

9.1. JBOSS CENTRAL

Lorsque JBoss Developer Studio 7.0 démarre, JBoss Centrale s'affiche dans la fenêtre principale du
workbench. De JBoss centrale, il est possible de créer de nouveaux projets en sélectionnant les options
de menu dans Start form scratch (Démarrer à zéro). On peut démarrer des exemples de projets
en sélectionnant les liens sous Start from a sample (Démarrer d'un exemple).

Figure 9.1. JBoss Central

Rapporter un bogue
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9.2. INSTALLATION DES PLUG-INS D'UN JBOSS DEVELOPER STUDIO

AVERTISSEMENT

Topic 9495, Revision 591882 failed validation and is not included in this build.

9.3. DÉFINIR LE RUNTIME DE DROOLS

Pour utiliser le plug-in JBoss BRMS dans Red Hat JBoss Developer Studio, il est nécessaire de définir le
runtime.

Un runtime est une collection de fichiers jar qui représentent une version spécifique du logiciel et fournit
les bibliothèques nécessaires à la compilation et à l'exécution des ressources d'entreprise.

Extraire les fichiers runtime jar qui se trouvent dans l'archive jboss-brms-engine.zip de l'archive zip
JBoss BRMS Generic Deployable (et non pas l'archive zip déployable EAP6) (disponible Red Hat
Customer Portal).

Procédure 9.1. Configurer le Runtime de BRMS

1. À partir du menu JBoss Developer Studio, sélectionner Window et cliquer sur Preferences.

2. Sélectionner Drools → Installed Drools Runtimes.

3. Cliquer sur Add...; fournir un nom de nouveau runtime, puis cliquer sur Browse pour naviguer
vers le répertoire où le runtime se situe. Cliquer sur OK pour enregistrer le runtime sélectionné
dans JBDS.

4. Indiquer que le runtime que vous avez créé est le runtime Drools par défaut en cliquant sur la
case adjacente.

5. Cliquer sur OK. Si vous avez des projets existants, une boîte de dialogue vous indiquera de
démarrer à nouveau JBoss Developer Studio pour mettre le Runtime à jour.

Rapporter un bogue

9.4. DÉFINIR LE RUNTIME DE JBPM

Pour utiliser le plug-in jBRM dans Red Hat JBoss Developer Studio, il est nécessaire de définir le
runtime.

Un runtime est une collection de fichiers jar qui représentent une version spécifique du logiciel.

Si vous avez déjà téléchargé l'archive zip standard déployable de JBoss BPM Suite à partir de Red Hat
Customer Portal, les fichiers jar qui composent le runtime se trouvent dans l'archive jboss-bpms-
engine.zip.

Procédure 9.2. Configurer le Runtime de jBPM


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1. À partir du menu JBoss Developer Studio, sélectionner Window et cliquer sur Preferences.

2. Sélectionner jBPM → Installed jBPM Runtimes.

3. Cliquer sur Add...; fournit un nom pour le nouveau runtime, et cliquer sur Browse pour
naviguer dans le répertoire où le runtime se situe.

4. Cliquer sur OK, sélectionner le nouveau runtime, et cliquer sur OK à nouveau. Si vous avez des
projets existants, une boîte de dialogue vous indiquera de démarrer à nouveau
JBoss Developer Studio pour mettre le runtime à jour.

Rapporter un bogue

9.5. CONFIGURATION DU JBOSS BPM SUITE SERVER

JBoss Developer Studio peut être configuré pour exécuter Red Hat JBoss BPM Suite Server.

Procédure 9.3. Configurer le serveur

1. Ouvrir la vue jBPM en sélectionnant Window → Open Perspective → Other et sélectionner 
jBPM, puis cliquer OK.

2. Ajouter la vue de serveur en sélectionnant Window → Show View → Other... et en
sélectionnant Server → Servers.

3. Ouvrir le menu de serveur en cliquant à droite le panneau de serveurs et en sélectionnant New
→ Server.

4. Définir le serveur en sélectionnant JBoss Enterprise Middleware → JBoss Enterprise
Application Platform 6.1+ et en cliquant sur Next.

5. Configurez le répertoire d'accueil en cliquant sur le lien , puis sur le bouton Browse.
Recherchez et sélectionnez le répertoire d'installation de JBoss EAP 6.1.1 qui a JBoss BRMS
Suite installé.

6. Donnez un nom au serveur dans le champ Name, assurez-vous que le fichier de configuration
est défini à et cliquer sur Finish.

Rapporter un bogue

9.6. IMPORTER LES PROJETS D'UN RÉFÉRENTIEL GIT DANS JBOSS
DEVELOPER STUDIO

JBoss Developer Studio peut être configuré pour se connecter à un référentiel central de ressources Git.
Le référentiel est l'endroit où sont stockées les versions de règles, les modèles, les fonctions et des
processus. Ce référentiel Git doit déjà être défini par le Workbench de KIE.

Les utilisateurs peuvent soit importer un référentiel local Git, soit cloner un référentiel Git distant.

Procédure 9.4. Importer un référentiel local Git

1. Démarrer le serveur Red Hat JBoss BRMS Suite (s'il n'est pas déjà en cours d'exécution) en
sélectionnant le serveur à partir de l'onglet Serveur et en cliquant sur le bouton Start.
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2. Sélectionner File → Import... et naviguez dans le fichier Git. Ouvrir le dossier Git et sélectionner
Projects from Git puis cliquer Next.

3. Sélectionner la source du référentiel en tant que Existing local repository et cliquer sur Next.

Figure 9.2. Informations sur le référentiel Git

4. Sélectionner le référentiel qui doit être configuré à partir de la liste de référentiels disponibles.

5. Importer le projet en tant que projet général dans la prochaine fenêtre et cliquer sur Next.
Nommez ce projet et cliquer sur Finish.

Procédure 9.5. Cloner un référentiel GIT distant

1. Démarrer le serveur Red Hat JBoss BRMS Suite (s'il n'est pas déjà en cours d'exécution) en
sélectionnant le serveur à partir de l'onglet Serveur et en cliquant sur le bouton Start.

2. Démarrer en même temps le serveur Secure Shell, s'il n'est pas déjà en cours d'exécution, en
utilisant la commande suivante. La commande est spécifique à Linux ou Mac. Sur ces plates-
formes, si sshd a déjà démarré, cette commande échouera et vous pourrez ignorer cette étape.

3. Sélectionner File → Import... et naviguez dans le fichier Git. Ouvrir le dossier Git et sélectionner
Projects from Git puis cliquer Next.

4. Sélectionner la source du référentiel en tant que Clone URI et cliquer sur Next.

5. Saisir les détails du référentiel Git dans la prochaine fenêtre et cliquer sur Next.

/sbin/service sshd start
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Figure 9.3. Informations sur le référentiel Git

6. Sélectionner la branche que vous souhaitez importer dans la prochaine fenêtre et cliquer sur
Next.

7. On vous donnera alors l'option de définir le stockage local pour ce projet. Saisir (ou
sélectionnez) un répertoire non-vide, apporter des modifications de configuration et cliquer sur
Next.

8. Importer le projet en tant que projet général dans la prochaine fenêtre et cliquer sur Next.
Nommez ce projet et cliquer sur Finish.

Rapporter un bogue

9.7. CRÉATION D'UN PROJET DROOLS

Procédure 9.6. Créer un nouveau projet Red Hat JBoss Developer Studio
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1. À partir du menu principal, sélectionner File → New → Project.

Sélectionner Drools → Drools Project et cliquer sur Next.

2. Saisir un nom pour le projet dans la case Project name: et cliquer sur Next.

NOTE

JBoss Developer Studio donne l'option d'ajouter un exemple de fichier
HelloWorld au projet. Accepter cette valeur par défaut en cliquant sur Next afin
de tester l'échantillon de projet par les étapes suivantes :

3. Sélectionner le temps d'exécution (ou utiliser la valeur par défaut).

4. Sélectionner un code compatible avec Drools 6.0.x. Saisir GroupID, un ArtifactID, et
une Version, et cliquer sur Finish.

5. Pour tester le projet, cliquer à droite sur le fichier Java qui contient la méthode principale, et
sélectionner Run → run as → Java Application.

La sortie s'affichera dans l'onglet de console.

Rapporter un bogue

9.8. CRÉATION D'UN PROJET JBPM

Procédure 9.7. Créer un nouveau projet Red Hat JBoss Developer Studio

1. À partir du menu principal, sélectionner File → New → Project.

Sélectionner jBPM → jBPM Project et cliquer sur Next.

2. Saisir un nom pour le projet dans la case Project name: et cliquer sur Next.

NOTE

JBoss Developer Studio donne l'option d'ajouter un exemple de fichier
HelloWorld au projet. Accepter cette valeur par défaut en cliquant sur Next afin
de tester l'échantillon de projet par les étapes suivantes :

3. Sélectionner le temps d'exécution de JBPM (ou utiliser la valeur par défaut).

4. Sélectionner génération de code compatible avec jBPM 6 or above, et cliquer sur Finish.

5. Pour tester le projet, cliquer à droite sur le fichier Java qui contient la méthode principale, et
sélectionner Run → run as → Java Application.

La sortie s'affichera dans l'onglet de console.

Rapporter un bogue
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CHAPITRE 10. BUSINESS RESOURCE PLANNER
Business Resource Planner est disponible en aperçu technologique dans Red Hat JBoss BRMS Suite.
Business Ressource Planner est un moteur de planification léger, encastrable qui optimise les
problèmes de planification. Il aide les programmeurs Java TM à résoudre efficacement les problèmes de
planification, et il allie une optimisation heuristique et métaheuristique à des calculs de scores très
efficaces.

Les planificateurs proposent des solutions à des cas variés comme ceux qui suivent :

Employee/Patient Rosters. Les planificateurs aident à la création de planning horaire à
l'intention des infirmières qui souhaitent garder une trace des plans de gestion d'un malade au
lit.

Educational Timetables. Les planificateurs aident à programmer des leçons, des cours, des
examens, et des présentations de conférences.

Shop Schedules : les planificateurs suivent les progrès de lignes de montage de voitures, de
lignes de montage de machines, et aident à la création des plannings de la main d'oeuvre.

Cutting Stock : les planificateurs réduisent la consommation de ressources comme le papier ou
l'acier.

Rapporter un bogue

10.1. INSTALLATION DU BUSINESS RESOURCE PLANNER

1. Naviguez dans Red Hat Customer Portal et connectez-vous par vos informations d'identification
utilisateur.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu Products, sélectionner BPM Suite.

4. Dans le menu déroulant Version, sélectionner la version de prod 6.0.2.

5. Sélectionner Red Hat JBoss BRMS 6.0.2 Business Resource Planner puis cliquer
sur Download.

Rapporter un bogue

10.2. EXÉCUTER LES EXEMPLE DE BUSINESS RESOURCE PLANNER

1. Sur ligne de commande, déplacez-vous dans le répertoire examples/.

2. En environnement Unix, exécuter la commande suivante :

./runExamples.sh

En environnement Windows, exécuter la commande suivante :

./runExamples.bat
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3. Sélectionner un exemple de l'application Examples GUI qui s'ouvre et l'exécuter dans votre IDE
favori.

Rapporter un bogue
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ANNEXE A. HISTORIQUE DES RÉVISIONS
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